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Preface 

TARGET AUDIENCE 
This manual is intended for developers responsible for using Black Duck Code Sight to search their projects.  

Tasks for getting started with Code Sight are divided into two paths: administrative tasks and search user tasks. The 
administrative user sets up the Code Sight environment to crawl and index your projects. This is described in the 
Black Duck Code Sight System Administrator's Guide. Search users (likely, software developers) access the HTML 
search page to examine their code. This document describes the search user tasks. 

 

RELATED DOCUMENTS 
The documentation for Code Sight is included in the top-level directory of the installation media. It consists of: 

Title File Description 

System Administrator's Guide AdminGuide.pdf Administrative and Configuration tasks. 

Release Notes RelNotes.pdf Description of what has changed from the previous 
release.  

Installation Guide InstallationGuide.pdf Detailed installation instructions for Code Sight. 

Note: After installation, the printable books are available from links on the "Welcome" page in the online 
help of the search application. 

The installation and admin guides are also located in C:\Program Files\Black Duck 
Software\CodeSight\doc. (This directory may vary depending on your operating system.) 

CUSTOMER SUPPORT 
Support for Code Sight is handled through an online support forum: 

http://www.blackducksoftware.com/code-sight/support/forum/ 

http://www.blackducksoftware.com/code-sight/support/forum/
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INTRODUCTION 

 

1 INTRODUCTION 

A significant portion of application development involves a process of find, copy, paste, and integrate. This 
process can be greatly accelerated when you can find and download existing source code that has already been 
debugged, tested, and approved. Code Sight makes it easy for software developers to find code in source code 
repositories that they have access to. Once you have found an interesting file, you can download it for use in a new 
project. 

1.1 Code Sight Process 

The basic process of using Code Sight is as follows: 

1. Your system administrator configures Code Sight to access all of your company’s code repositories. 

2. Code Sight automatically examines the projects and publishes an index. It revisits the repositories regularly to 
look for new or updated files. 

3. You search the code in your projects using the Code Sight search page.  

4. When you find what you need, you can download the file. 

Tip: Code Sight is designed to search all of your company’s projects and repositories so that you can 
reuse a file in another project. If you are searching for a file so that you can make changes to it and 
replace it in the same project, it is important to note that downloading a file from Code Sight does not 
check it out from your source control system. You must use your regular source control commands to do 
that. 

1.2 Logging In 

Your system administrator can configure Code Sight such that some (or all) projects can only be searched by 
registered users. If your system is not open, then you will need to log in when you want to search for code. Your 
login information will be compared to a list of users associated with each project, and this determines whether you 
are able to search and view files in the index.  

Click the Login link on the main search page. 

 

1 
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Enter the username and password provided by your Code Sight administrator. Note that the password is case 
sensitive. 

  

When you log in to your registered account, you are presented with a new search page that shows an updated count of 
lines and projects. Depending on the roles granted to your account, the page may also now include a link to the Admin 
area. See the Code Sight Administrator’s Guide for information about the administrative features.   
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1.3 What Can I Search For? 

The following is a partial list of things you can do with Code Sight: 

• Search for a code string to find a matching snippet in another file or project 

• Search all projects across multiple repositories simultaneously 

• Search for a project by its description or name 

• Find a file in any repository and download a local copy of the file (search for filenames) 
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SEARCHING FOR CODE 

 

2 SEARCHING FOR CODE 

Note: Code Sight allows you to search all files, file names, and project descriptions. It applies special 
indexing to files that it recognizes as code, and uses its most advanced indexing techniques to files it 
recognizes as C#, Java, and Python. This feature allows you to perform advanced searches for classes or 
methods in those files. 

2.1 Basic Search 

To search for code, first open a web browser and direct it to a Code Sight server. On a local machine, Code Sight 
is installed by default at: http://localhost/. For enterprise installations, the proper URL can be obtained from your 
system administrator. 

Tip: You can search billions of lines of open source code at http://www.koders.com or by using the 
Black Duck Code Search plug-in. 

Type your search term(s) into the search field and press the ‘Enter’ key or click the Search button to submit your 
query. Your search results are presented in the order of relevance to your query based on the following ranking 
order:  

• Exact matches on identifiers rank higher than matches on file names 

• Matches on file names rank higher than fuzzy matches on identifiers 

• Exact case matches rank higher than case-insensitive matches 

• Results with more of your terms will rank higher 

• Results with the terms in the same order that you entered them will rank higher 

• Results with multiple instances of your terms will rank higher 

2 

http://www.koders.com/
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After you review your search results, you may want to further refine your query. The next sections describe 
different ways to narrow or expand your search results. 

2.2 Searching for Phrases 

Consider that you are searching for usage of Apache Tomcat in your projects. If you search for the words together 
in a quoted string, “Apache Tomcat”, then Code Sight finds and presents files with the following results: 

• the exact string match 

•  the words separated by ignorable characters, such as backslashes 

• matches where the terms are near each other, in the order specified in the search string. 
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If instead, you searched for the terms without quotes, then Code Sight would find the words anywhere in your 
files. The results page is sorted to first show the files where the search terms are closer together. Note in this 
example, the search found more than twice as many results for the unquoted query. 

Tip: In general, matching is case-insensitive. However, exact case matches are given precedence and are 
shown higher in the results. Also, Code Sight performs some tokenization based on CamelCase terms in 
your query. For example, searching for “blackduck” is treated differently than searching for “BlackDuck”. 
The latter is recognized as being composed of two words, and therefore Code Sight can search for Black 
and Duck separately.  
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2.3 Filter by Language 

As Code Sight examines your projects, it recognizes a wide variety of programming languages via their file types. 
This allows you to find relevant source code written in a specific programming language. 

Recognized languages: 

ActionScript Ada ASP ASP.NET Assembler 

Boo C C# C++ Cobol 

ColdFusion Delphi Ecma Eiffel Erlang 

Fortran F# Groovy Haskell Java 

JavaScript JSP Lisp Lua Mathematica 

Matlab Modula ObjectiveC Ocaml Perl 

PHP Prolog Python REBOL Rexx 

Ruby Scheme Smalltalk SQL Tcl 

VB VB.NET Xml   

You can filter your search results by selecting the checkbox of your desired language. Note that the “NonCode” 
entry includes files such as .log and .html, which are available for basic searching but are not parsed and indexed 
for source content. 
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2.4 Project Matches 

When search terms are found in the names or descriptions of projects, Code Sight also returns project matches. 
The project matches are displayed on the right-hand side of the search results in a box of their own.  

You may select a project from the results list to call up additional information on the source makeup, development 
costs, and repository directory structure.  

 

The Search Results page presents a summary of matches in order of relevance to your search query. Each result 
item also includes the snippet of code within the file that contains the matched term. Clicking on any linked file 
will take you to the associated Code View page.  

 

A file's language and lines of code are shown here, as well as the project and repository to which it belongs. The 
project name is hyperlinked, allowing you to view that project's summary page. 
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2.5 File View 

The Code Sight search results page shows snippets of code with your matching search term. It also includes links 
to the specific file and to the project where that match was found. Click the file name to display the File View page. 

The File View page displays the contents of a file. You can cut and paste from the view, or you can download the 
entire file and save it to your local system. You can also browse other files in the current directory or link to the 
file's project page. Source code is displayed with language-specific and search term highlighting. 

 

The File View page contains the following elements: 

A      File download link 
Clicking this link allows you to download and save the file to your computer. 

B      File name and meta data 
The file name, its language and number of lines of code are displayed here. 

C      Project Info 
This section shows the project and the repository to which a file belongs. The project name is hyperlinked to its 
Project Summary page. 

D       Code View 
The file's contents are displayed here. The code is numbered and colored coded. Your search term is highlighted to 
indicate where matches where found. Additionally, all tokens in the code are hyperlinked. Clicking on these allows 
you to search that token within other files in the current project. Line numbers are linked to allow external, 
persistent links to specific file locations. This allows developers to link bug reports or forum postings directly to 
the location of a code bug or reference. 

E     File directory listing  
This section shows you a directory listing of the current file. You can click on other files to view them or click on 
the folder icon to go to the Project Summary page. 

F     Class summary 
If the code contains classes, its methods and fields are summarized here. 
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2.6 Project View 

Clicking on a project name from the search results shows the Project View page.  

 

A      Project file explorer 
The project's file tree is displayed in this area. All files within a project are organized within folders. Clicking on a 
folder will expand its contents. This section displays an overview of the files in a directory. The filename, size, 
language, license, lines of code, and lines of comments are displayed. Each file is linked to its own Code View page. 

B      Bread-crumb file hierarchy 
Allows you to navigate to a different level in the file tree. 

C      Project Statistics  
This area displays basic statistics about the project such as the repository name and type, number of files in the 
project, and total lines of code. 

D       Development Cost 
The project Cost Calculator estimates a project's value. If you were to code this project from scratch, you could 
expect to spend the total amount, based on certain assumptions. You can modify the assumptions to see the 
impact on development cost and estimate the potential savings from reuse of existing code. 

E     Languages breakdown  
This section displays a breakdown of programming languages used within a project in a pie chart. 
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3 REPORTING 

Code Sight provides a set of reports on your indexed source-code base and search statistics. You can access these 
reports from the Reports link at the top of the Code Sight search page (http://<codesightserver>). 

 

The following reports are available.  

Report Name Description 

Language Breakdown A breakdown of source code by language. 

Published Projects The current status of all projects on your system. 

Queries with No Results List of the top search terms where the number of hits is zero. 

Top Searches The most frequent search queries used by your users. 

Usage Statistics A basic usage overview of the system.  
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3.1 Language Breakdown Report 

Shows the percentage of source code by language across all repositories. A similar chart is available for projects on 
the project page (see Section 2.6). 
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3.2 Published Projects Report 

The Published Projects report shows a list of all projects on the system. Clicking on a project name takes you to 
the project page. (See Section 2.6 for a description of the project page.) 

 

3.3 Queries with No Results 

A list of the top search terms where the number of hits is zero. This is useful for showing feature gaps in your 
codebase. 
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3.4 Top Searches Report 

The most frequent searches issued by your users. 

 

 

 

3.5 Usage Statistics Report 

The Usage Statistics report shows an overview of the system including total searches and downloads. 
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4 USING PLUG-INS AND INTEGRATIONS 
Important: The plug-ins are being updated and released separately from Code Sight 2.0. The currently-
available plug-ins support searches locally with your Code Sight 1.4 server, and universally with 
Koders.com. When the new plug-ins are released, this documentation will be updated.  

Code Sight IDE plug-ins enable software developers to easily search and reuse source code from within their 
chosen workspaces. The plug-ins enhance Integrated Development Environments (IDEs) by extending the reach 
of the Black Duck Koders.com open source code index to the desktop. The plug-ins, which can be downloaded 
for free at http://www.blackducksoftware.com/code-sight/plugins, are available for Eclipse and Visual Studio, 
two of the most popular IDEs. 

The plug-ins feature Code Sight SmartSearch™ an innovative service that monitors software applications as they 
are being written and visually notifies developers of opportunities to leverage existing code. By seamlessly 
integrating code discovery and reuse into the software development process, these technologies increase 
productivity, accelerate time-to-market, reduce software defects and lower development cost. 

This section also describes methods of integrating Code Sight search into other applications and enhancing the 
Code Sight search application. It also covers adding the Code Sight search widget to a web page.  

Tip: Save disk space and processing cycles by not adding open source projects to your own index. 
Instead, use a plug-in to search both your local files and Black Duck Koders.com. Black Duck maintains 
the largest open source index, containing over 3.3 billion lines of code. 

4.1 Plug-in Features 

Boolean Search: Finds reusable code from your Code Sight index or from Koders.com by searching from within 
the most popular IDEs using simple syntax or advanced filtering for limiting scope to specified programming 
languages or projects. 

SmartSearch™: Provides real-time recommendations by monitoring new code as it is created and visually 
notifying developers of opportunities to reuse existing software source code assets. 

Language Localization™: Supports English, German, Russian and Hindi, and also allows developers to localize 
the plug-ins for additional languages. 

4 
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4.2 Eclipse Plug-in 

The Code Sight Eclipse Plug-in offers full search functionality within Eclipse, so that developers do not need to 
switch between programs. The plug-in also searches code available by the local installations of Code Sight and the 
Black Duck Koders.com web site. 

 
The Eclipse IDE plug-in works with Eclipse version 3.0 and above. You can get more information from the 
following location: http://www.blackducksoftware.com/code-sight/plugins.   

After installation, the Code Sight Search tool window is available in the “Window” menu of the IDE. If it is not, 
go to “Manage Configuration” under the “Help Software Updates” menu to ensure that Code Sight is correctly 
installed and available. 

4.2.1 Installation 

You can install the Black Duck Code Sight plug-in using the Eclipse update manager, as follows: 

1. Within Eclipse, select Help  Install New Software…  

2. Click the Add… button and enter the location of the plug-in as shown on the Black Duck web site.  

 

3. Select the new location, and click the Next button. 

4. The system shows the installation details. Click Next again. 

5. Read and accept the license agreement.  

http://www.koders.com/
http://www.blackducksoftware.com/code-sight/plugins
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6. Click Finish. 

7. During the installation, the installer may present a security warning about unsigned content. Click OK to 
continue. 

 

8. Restart Eclipse for the changes to take effect. 

4.2.2 Usage Notes 

SEARCHING 
The Code Sight Plug-in enables you to search the index from inside your IDE and opens results in browser 
window inside the Eclipse IDE. 

To search, right-click on some text in your editor window and select “Code Sight Search” in the context menu. 

 

A new view opens in Eclipse with your search results.  
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 FILTERING SEARCHES AND SETTING SCOPE 
The plug-in enables you to filter your search with the following criteria:  

• Language (for example: Java, C++, Perl) 
• License (only for Open Source searches) 
• Scope (select Open Source to search Koders.com, or Enterprise to search your local Code Sight repositories.) 

 

PREFERENCES AND ENTERPRISE SETTINGS 
Here you can enter your “Enterprise Search” URL and set options such as the search history size. 

The Code Sight plug-in options can be set in two ways: 

• In the Options menu of the Code Sight Search window: 

 

• Or, in the Eclipse Preferences window (Window  Preferences) 
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The SmartSearch tab allows for customization of the plug-in’s behavior.  

 

 

UPDATES 
To check for updates for the Code Sight Plug-in, click “Check for Updates” in the drop-down menu next to the 
duck icon in the Black Duck Code Search window. 
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4.3 Visual Studio.NET Plug-in 

The Visual Studio.NET Plug-in Panel is designed for quickly using Code Sight search features without leaving 
Visual Studio. 

 
The Code Sight Add-In for Visual Studio .NET requires an installation of Visual Studio .NET 2005, 2008, or 2010 
to run. Go to the Black Duck web site to download the appropriate plugin. Once downloaded, double-click on the 
file to run the installer through its automated steps.  

 

After installation, the Code Sight Search tool window will be available in the “View  Other Windows - Black 
Duck Code Search” menu of the IDE. If it is not available, check the VS Add-in Manager under the “Tools” menu 
to ensure that Code Sight Search is installed.  

4.3.1 Plug-in Features 
The Code Sight Visual Studio.NET Plug-in offers full search functionality within Visual Studio, so that developers 
do not need to switch between programs. The plug-in also searches code available on both your local Code Sight 
server and the Black Duck Koders.com web site. 

4.3.2 Searching 
The Code Sight Add-in enables you to search the index from right inside your IDE and opens results in a browser 
window inside the VS IDE. To search Code Sight (both Koders.com and a local installation):  

• Enter a term in the search box. 

• or Right-Click a text/symbol in the editor window and click “Black Duck Code Search” in the context 
menu.  

http://www.blackducksoftware.com/code-sight/plugins
http://www.koders.com/
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4.3.3 Filtering Searches 
The plug-in enables you to filter your search with the following criteria:  

• Language (for example: Java, C++, Perl) 
• License (only for Open Source searches) 
• Scope (select Open Source to search Koders.com, or Enterprise Code to search your local Code Sight 

repositories.) 

 

4.3.4 Options and Enterprise Settings 
To access options, click “Options” in the Code Sight Search drop-down menu from the Code Sight tool window. 
Alternately, you can directly access the “Tools Options” menu in VS where you can select the “Code Sight Add-
In” options folder.  

Here you can enter your “Enterprise Search” URL and set the search history size. 

 

4.3.5 Updates 
To check for updates for the Code Sight Add-in, click “Check for Updates” in the Code Sight drop-down menu 
from the Code Sight tool window. 
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 4.4 HTML Web Integration 

You can integrate Code Sight search results directly into your own web-based application. HTML/DHTML code 
can be integrated into existing web page layouts to add standard Code Sight search boxes. When a user enters a 
search, they will be redirected to results on the Code Sight server. 

The following example is available for download from the online help. Search the help for “HTML Integration”. 

<html> 

<!-- 

  Copyright (C) 2011 Black Duck Software Inc. 

  http://www.blackducksoftware.com/ 

  All rights reserved. 

   

  This software is the confidential and proprietary information of 

  Black Duck Software ("Confidential Information"). You shall not 

  disclose such Confidential Information and shall use it only in 

  accordance with the terms of the license agreement you entered into 

  with Black Duck Software. 

 --> 

  

  

         <title> 

         Embedded Codesight Example 

         </title> 

         <head> 

         <script src="http://code.jquery.com/jquery-latest.js"></script> 

         </head> 

          

         <p>A simple html sample demonstrating the possibility of embedding a codesight  

         web page in an external web application.</p> 

         <hr/> 

         <div id="topCS"> 

         CodeSight Server URL: <input size="40"  

                 type="text" id="txtCSServer" 

                 value="http://product-codesight"/> 

          

         Query: <input size="60" type="text" id="txtQ" /> 

         <input  type="submit" value="Submit" id="btnSubmit"/> 

         </div> 

         <hr/> 

         <iframe src="" width="100%" height="80%" id="iCS"> 

                    

         </iframe> 

          

         <script> 
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                 function setUrl() { 

                          

                         var b = "eclipse"; 

                         var q = $('#txtQ').val(); 

                         var url = $('#txtCSServer').val(); 

                          

                         if (q == '' || jQuery.trim(q).length < 1){ 

                                 url = url + "?browser=" + b;      

                         } else { 

                                 url = url  

                                         + "?s="  

                                         + $('#txtQ').val()  

                                         + "&browser=" + b; 

                         } 

                          

                         $('#iCS').attr('src', url); 

                 } 

          

                 $('#btnSubmit').click(setUrl); 

                  

                 $(window).load(setUrl); 

                  

                 // $('iframe#iCS').load(function() { 

                 //       

                 // }); 

          

         </script> 

          

 </html> 

Tip: The page in the online help also allows you to test this example using your own server. Simply 
change the URL for the Code Sight server to match your own location. In this example, the server is set 
to: http://product-codesight. 

 

http://product-codesight/
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